
 

10 Quick Things to Know
1. File Browser. RAW Power includes a file browser to let you easily view 

folders and images on your disk. You choose which folders to include, and can 

create favorite folders for even faster access.

2. Batch Processing. The new thumbnail grid in RAW Power enables you to 

make changes to multiple images at once, in the background. This is called 

Batch Processing. Simply select multiple images in the grid (using the Shift key 

or Command key) and right-click to:

- Apply a Preset

- Paste adjustments from another image

- Revert to Original

3. Batch Export. You can also export multiple images at once, with control 

over the size, color profile, file format, bit depth and the name of the files too.

4. Windows and Tabs. RAW Power supports multiple windows and tabs. You 

can have different windows pointing at different parts of your disk, you can 

dock them into a single window using tabs, or any mix of the two. You can also 

open multiple images for editing at the same tie.



5. Extension. RAW Power includes a Photos extension which is the best way to 

use RAW Power if you use Apple's Photos.app. This extension provides all of 

the same editing features as the regular RAW Power app, and it's built right in. 

To use it, select an image in Photos for editing. Click on the "..." button and 

select RAW Power. Note: do not use Photos' Edit With function, as that does 

not send RAWs to RAW Power.

6. Boost. Boost is one of the most important controls in RAW Power's 

adjustment toolbox. 

A slider in the RAW Processing adjustment, Boost controls the “look” of the 

RAW image. By default, RAW images can look very flat, and lack contrast or 

“punch.” Boost provides that contrast and punch. This is good for well-

exposed images, but bad for over-exposed images. For the best highlight 

recovery for RAWs, set Boost to 0.5 or less. Also, if you want to have the least 

processing done to your images before applying your own, set Boost to 0.0 to 

shut it off completely. Learn more in the RAW Processing help page.

7. Hot Pixel Overlays. Next to the word "Histogram" in the adjustment panel, 

there are four circles.

If they are lit, then your image has over-exposed (clipped) areas. If you click on 

the circles, RAW Power will draw an overlay to show you which pixels are over-

exposed. The gray circle will display red for pixels that are clipped in at least 

one channel, and blue for pixels that are 0.0 in all channels (completely black). 



There are also "Photoshop-style" overlays that show multiple colors -- see the 

information on the Tone adjustment to learn more.

8. Depth Effect and other image formats. While RAW Power is optimized for 

RAW images, it can adjust JPEGs, TIFFs, PNGs and other formats. If you have a 

JPEG shot with a dual-camera iPhone, you can use RAW Power's Depth Effect 

to manipulate the foreground and background independently.

You can also view and manipulate the depth data itself with this adjustment. 

9. iOS and iCloud. When you adjust images with the RAW Power Extension for 

Photos, changes are non-destructive, and stored in the Photo library. Further 

edits are also non-destructive. If you use iCloud Photo Library, edits you make 

with RAW Power's Photos Extension are synched over iCloud. You will see 

them on any other device using iCloud Photo Library (Mac and iOS). You can 

download RAW Power for iOS, which has all of the same adjustments as the 

Mac version, and can read and continue edits you make on the Mac.

10. Perspective, Black and White, Chromatic Aberration and More. RAW 

Power has a wide range of adjustments to correct and improve your photos. 

Black and White can produce attractive monochromatic images similar to those 

shot with color filters. Chromatic Aberration can correct color artifacts and 

Perspective can straighten buildings and other structures that are shot at an 



angle. The Vignette adjustment allows you to control the center of the 

vignette, which is especially helpful when your subject is not in the center of 

the image.



New Features in RAW Power 2.0

New Adjustments (Photos Extension and Standalone App)
• Chromatic Aberration
• Perspective
• Black and White (a Monochrome Mixer)
• Vignette with Controllable Center Point
• Enhance including Definition

Features in the Standalone App:
• File Browser

⁃ Browse folders on your disk
⁃ Establish favorite folders
⁃ Metadata view with a map
⁃ QuickLook
⁃ Move to Trash / Reveal in Finder

• Batch Processing in the Background
⁃ Batch Apply Presets
⁃ Batch Paste of Adjustments
⁃ Batch Revert to Original
⁃ Batch Export with Custom Naming
⁃ Background Processing Task View

• Multiple Windows
⁃ Multiple Browser Windows (View different parts of your disks at 

once)
⁃ Multiple Editor Windows (Open and edit multiple files at once)
⁃ Full Support for Tabbed Windows
⁃ Collapsible Panels

• Thumbnail Grid
⁃ Control over thumbnail sizes
⁃ “Adjusted” badge in the thumbnail grid
⁃ Filter to show RAWs only

• Full Dark Look in macOS Mojave



Note: You can open individual files with the Open menu to make quick 
adjustments to images. Like Browser windows, you can have as many of 
those open as you like (and put them in tabs).



RAW Power Overview
RAW Power uses Apple’s RAW engine to decode images, so any image you 

open in RAW Power looks the same as it would in Photos, Aperture, or iPhoto. 

This is one of RAW Power’s key advantages. It also supports hundreds of RAW 

camera formats, as well as DNGs and iPhone RAW images. You can watch video 

tutorials of RAW Power on YouTube at: 

<https://www.youtube.com/channel/UC7l78rOzFxaHG-e5AT-MGWQ>. 

If you are using iCloud Photo Library, any adjustments you make to images with 

RAW Power for iOS will be synchronized to the photo library on your Mac. You 

can continue non-destructively editing those images with RAW Power for Mac, 

using the Photos extension (and return to iOS again, if you like). Due to 

limitations in macOS, the standalone application cannot edit images from 

iCloud. 



The File Browser
The File Browser Window is the heart of RAW Power 2.0. Use this window to 

peruse the images on your computer, select them for editing, and perform 

operations on multiple images at once (“Batch Processing”).

At the top of the window is the toolbar:

There are standard navigation buttons, a button to show only RAW images and 

controls to add and remove folders from the browser window. 

Because RAW Power is "sandboxed," it does not have access to files on your 

computer unless you explicitly give it permission. You give permission by 

clicking the Add Folder button and selecting a directory for RAW Power to 

display. You can remove a folder at any time by selecting it and pressing the 

delete key or control-click to display a menu.



The left side of the window is the “Browser” itself. There are two sections: In 

Favorites, put your most commonly accessed folders. That section only shows 

the contents of the folder (not sub-folders), so it may not be suitable for a 

directory like “Pictures”. The second section, Locations, is where you can put 

folders that contain hierarchical information (such as all the photos for a year, 

organized into subfolders by month. You can drag folders between the two 

sections. The line between Favorites and Locations can be moved if you need 

more space for Favorites and the Browser itself can be made wider or narrower.

Use the Back / Forward buttons as you would in a web browser.



Tabs and Windows
RAW Power 2.0 supports multiple tabs and multiple windows. That means that 

you can view multiple folders of your computer at the same time and manage 

your workspace the way you like. If you prefer to keep everything in one 

window, use tabs. If you prefer to have separate windows, then work that way. 

Or combine the two approaches.

TIP: If you hold the Command key down when you click on a folder in the 

browser, it will create a new tab pointing at that directory.



The Grid / Filmstrip
When you select a folder in the browser, RAW Power will display the images in 

one of two ways:

1) A Viewer + Filmstrip at the bottom

2) A grid of thumbnails

You can choose which one by pressing "V" or clicking on the Viewer button in 

the Toolbar.

Next to the Viewer button is a popup menu that controls the thumbnail size 

and visibility of the filmstrip.

The QuickLook button works like the one in the Finder - press the button or tap 

the spacebar to quickly see a large version of your image. RAW Power's 

QuickLook is much faster than the one in the Finder. It is especially useful when 

you are looking at a lot of images in the thumbnail grid. Just tap the spacebar, 

and you will see a full-size image. The RAW will also be decoded for full-fidelity.

When you select an image, metadata appears on the right side:



You can also select multiple images in order to perform batch operations, like 

export or apply presets (see the topic on Batch Processing). When you select 

multiple images, one image is the "primary" selection and is the one that will 

be edited or have its metadata displayed. The primary is denoted by a thicker 

border around the image.





Export
RAW Power provides multiple options for exporting images. The options 

depend on whether you have a single image selected or multiple ones. In both 

cases, begin exporting by choosing File > Export.

Single Image Export:

Note: if you cannot see these options, click the "Options" button at the 
bottom of the Save dialog.

1) Output Size: allows you to export a full size image or a choice of preset sizes. 

You can also select "Custom" and enter the size you would like.

2) Format: JPEG, TIFF (8 and 16 bit), PNG (8 and 16 bit) are options

3) For JPEGs, you can select a few preset compression options

4) Color profile

5) DPI / PPI allows you to tag the image for print. Some printers use this tag to 

determine the physical output size to print the image. It has no affect on the 

quality of the exported image.



6) Show in Finder will open the folder containing the exported images (and 

select those images when export completes).

Export operates in the background.

Multiple File Export:

In this situation, you select the directory for the export files to go, and you can 

use the additional options to name the exported files as you choose. You can 

use the original file name, the file name + date, and the file name plus an 

incrementing sequence number.

Note: the menu item will change to show the number of items to export:





Batch Processing
RAW Power can perform the following operations on more than one image at a 

time:

1) Export

2) Apply Preset

3) Paste Adjustments

4) Revert to Original

5) Generate Thumbnails

6) Reveal in Finder

7) Move to Trash

The first five operations take place in the background. To use the batch 

processing feature, select multiple images in the grid or filmstrip (NOTE: batch 

processing does not apply to the Single File Editor, described i in a separate 

section).

Once you have selected more than one image, you can use the menus at the 

top of the screen, or control-click on a selected image to bring up the 

contextual menu.

While RAW Power is working on the images, the task toolbar button will 

update. You can click on the button to see detailed status.



Tasks cannot be cancelled individually. However if you quit RAW Power, all 

outstanding tasks will stop.



Single File Editing
While the typical way to use RAW Power is through the File Browser, it can also 

be used as a single-image editor (as in previous versions).

To do this, use File > Open, Open Recent, or drag one or more files to the 

application icon.

When you do this, RAW Power will open one new window for each file with just 

the editing environment displayed:

In this window, you can adjust the image (non-destructively) and export the 

adjusted image when you are done. Click the Cancel button to discard your 

edits or File > Save Edits to save them.

Note: You cannot use any of the batch processing commands in Single File 
Editor mode.



For details on editing images, see the section on Editing.



Working with Photos.app
RAW Power is a hybrid that works both as a standalone application and as an 

extension to Apple's Photos application. If you manage your photos with 

Apple's application, then you are best served by using the RAW Power 

extension.

To do this, select an image in Photos and enter Edit. From the "..." button, 

select RAW Power. If you do not see RAW Power listed, then select the More… 

option to enable it in Photos.

Edits you make in the RAW Power extension are saved into the Photos library 

directly. The original image is not modified. You can return to RAW Power at a 

later date and continue editing non-destructively. Note that edits made by the 

extension are not accessible to the standalone application.

If you use iCloud Photo Library, edits are visible to RAW Power for iOS.

Important note: Do not use the Edit With > feature of Photos. That feature is 

intended for applications that do not have Photos extensions. As a result, 



Photos will create a TIFF from the original image and you will be unable to use 

any of RAW Power's RAW processing controls.

To use RAW Power as a standalone app, open it from LaunchPad or from the 

Applications folder in the Finder. RAW Power automatically opens the last file 

you used with it. There are virtually no differences between the extension and 

standalone modes, except as follows:

Extension App

Output Options JPEG only JPEG and TIFF

Preferences Button in window Menu item

Adjustment 
storage

Inside Photo library Sidecar files in 
sandbox 
container

Target file Depends User selected

The last line demands clarification. When using the standalone app, you 

choose which file to work on. When you use the Photos extension, you choose 

the “image” to work on, not a specific file. Photos decides which file to send as 

shown below:

Image State What RAW Power receives

Unadjusted Original file

Adjusted by Photos Full-size JPEG with adjustments 
applied

Adjusted by other extension Full-size JPEG with adjustments 
applied



If you adjust the image in Photos or in another extension, then Photos sends a 

JPEG image to RAW Power that includes those adjustments. RAW Power does 

not receive the original in that situation (and there is no way for it to get the 

original). For example, if you apply Auto Enhance to a RAW in Photos, and then 

select RAW Power, then Photos will send a JPEG to RAW Power that has been 

auto-enhanced. The same is true for crop, straighten, filters, rotate, etc. For 

best results, do not adjust the image in Photos before using RAW Power. You 

can tell if this happened because a yellow warning triangle appears in the 

toolbar at the top right of the RAW Power interface, and by the absence of the 

RAW Processing adjustment.

Apple requires Photos extensions to produce JPEGs and does not support 

other formats produced from extensions. The extension stores its adjustment 

data in the Photo library. In contrast, the standalone app stores adjustment 

information in its “sandbox container” which is located at:

(Home)/Library/Containers/com.gentlemencoders.RAWPower/Data

A separate sidecar is stored for each original file that is adjusted. RAW Power 

connects the sidecar with the original using a combination of original file name 

and certain metadata (like image size). The directory or volume are not 

considered, so you can move the original file anywhere and RAW Power will still 

be able connect it to the adjustment sidecar. However, if you rename the 

original file, RAW Power will not associate the original with the old sidecar. 

Both the extension and the app are sandboxed, so they have very restricted 

access to your files.



Editing
RAW Power is fundamentally an image editor. It can edit a wide range of image 

formats, including RAW, TIFF, PNG, and JPEG. The only differences between 

image types are the following:

1) Only RAW images get the RAW Processing adjustment

2) Only iPhone images with depth get the Depth Effect adjustment

If you are in the RAW Power file browser, enter Edit by clicking on the Edit 

button in upper right of the toolbar.

All adjustments are non-destructive, in other words, adjustments do not modify 

the original file. They are saved separately from the original file. In addition, you 

can start editing the file, quit and continue again at a later date without losing 

quality or options. You can switch off any adjustment you have made in the 

past.

We will start the tour of RAW Power's editing features at the top of the editing 

panel:

The buttons are, in order: 

• Rotate: rotates the image clock-wise. Hold the option key to rotate 

counter-clockwise

• Flip: flips the image horizontally. Hold the option key to flip vertically.

• Show Original: shows the image without any adjustments except Crop, 

Flip, and Rotate.



• Info: shows metadata about the information (not available in the Extension 

- use Cmd-I in Photos)

• Zoom In, Zoom Out, Zoom to Fit, and Zoom to Actual Size

You can quickly zoom to 1:1 by double-clicking in the image view, or pressing 

the Z key. Repeat to return to Zoom-to-fit. You can zoom up to 800%. When 

you have zoomed about 100%, the Z key / double-click switch between 100% 

and that higher zoom level.

Below those buttons is the Presets menu.

Presets allow you to apply a collection of adjustments in a single operation. You 

can use the built-in presets, or create your own. To create a preset, click "Save 

as New Preset…". To edit the list, export, or import presets, select "Edit 

Presets…"

You can assign any preset as a Camera Preset (one preset per camera model). 

Once you do that, any image you open in RAW Power from that camera will be 

automatically adjusted with that preset. This is extremely useful if you want a 

specific look for all your images automatically. It's also useful for configuring 

Apple's RAW decoder (the RAW Processing adjustment) to your needs.

By default, RAW Power adds the preset to your image. Hold the option key to 



replace your existing adjustments with the preset. 

Below Presets is the Histogram and Hot / Cold Pixels controls:

The histogram shows the distribution of pixel values in the image. The "gray" 

channel uses a luminance weighting for red, green and blue (Luminance is 

designed to match the way the human eye perceives light). You can hide the 

histogram by clicking on the triangle next to "Histogram." 

Note: Hiding the histogram can also improve performance.

Next to the word Histogram are four colored circles. When these circles light 

up, the image has clipped pixels. Clipped pixels are pixels which have one or 

more channels that are brighter than the maximum allowed in a JPEG (or other 

integer format). You can click on the circles to show which parts of the image 

are clipped. The gray circle will show hot pixels (at least one channel clipped) 

and cold pixels (black, all channels at 0.0).

This is a sample image with clipped pixels:



After clicking the gray circle, this is the display:



If you click on the red, green, or blue circles, you will see the pixels clipped in 

those channels only.



Copy and Paste
In the standalone app, you can copy the current adjustments on the image and 

paste them onto another image. Since RAW Power only supports one image at 

a time, use this feature as follows:

• Edit > Copy Adjustments

• Open the file you want to paste the adjustments on

• Edit > Paste Adjustments

Like Presets, you have the option to add the adjustments to the target image, 

or to replace all of the adjustments with the copied ones. In addition, once you 

have copied adjustments from an image, you can select multiple images in the 

thumbnail grid and apply them all at once. To do this, right-click on one of the 

selected images and select Paste Adjustments.



Crop and Straighten
Unlike Aperture, RAW Power combines Crop and Straighten into a single 

adjustment. 

Aspect Ratio: This popup allows you to constrain the crop to a specific aspect 

ratio. There are also options for Unconstrained (free cropping) and Custom 

aspect ratios. When Custom is selected in the popup, the Custom fields 

immediately below the popup become enabled.

Size: This is the size of the image in pixels. You can type in a value for precise 

cropping.

Straighten: This slider allows you to rotate the image from -20 degrees to +20 

degrees.

Straighten Tool: This tool allows you to draw a line on the image to straighten 

it. This makes it easy to align the image by using a horizon, wall or other 

straight feature. A floating window appears when the tool is engaged. 

Crop Tool: With the Crop Tool, you can drag and position the crop box. A 

floating window appears with the megapixel size and a checkbox to show / 

hide rule-of-third guidelines.



If both crop and straighten are applied, the image is rotated in the Viewer to 

help crop the image more accurately. 





RAW Processing
RAW Processing is the adjustment at the core of RAW Power, providing unique 

control over Apple’s RAW Engine. All of the sliders are GPU accelerated and 

real-time, so adjustments appear as soon as you move a slider. There are a few 

older cameras that don’t have access to all of the below controls, but most do. 

Support for new cameras comes from Apple, which periodically releases Digital 

RAW Camera Updates. As of this writing, the list of supported cameras (and 

any limitations) is at: https://support.apple.com/en-us/HT207049. As a rule of 

thumb, if Apple’s Preview application can open an image file, then RAW Power 

can too.  

Note: The RAW Processing adjustment only appears if you are adjusting a RAW 

image.

Boost: this slider controls the “look” of the RAW image. By default, RAW 

images can look very flat and lack contrast or “punch.” Boost provides that 



contrast and punch. In general, this makes well-exposed images look good, but 

if you want the most control over your RAW images, decrease Boost to 0.5 or 

shut it off entirely by setting it to 0.0.

Black Boost: this slider adjusts the bottom or “black” end of the boost curve, 

allowing you to manipulate the darker parts of the image.

Luma Noise, Color Noise, Detail: These three sliders are part of Apple’s RAW 

noise reduction. Luma Noise controls the black-and-white noise in the image. 

The Color Noise slider controls the colorful speckles that appear in noisy 

images. Sometimes applying strong noise reduction can cause the image to 

look flat or “plasticky.” If that happens, consider increasing the value of the 

Detail slider. It restores some “grain” to the image to make it look more 

natural.

RAW Sharpen and RAW Contrast:  RAW Sharpen is a subtle form of capture 

sharpening which works at the Bayer mosaic level. RAW Contrast is a type of 

local contrast (which can look like sharpening). RAW Contrast generally has a 

lot stronger effect than RAW Sharpen. Both are image-dependent — the 

characteristics of the image affect how these sliders operate and affect the 

default values of those sliders.

Gamut Mapping: In its final processing step, Apple’s RAW engine ensures 

colors do not exceed the range of the working color space (Adobe RGB or P3). 

This is called Gamut Mapping. Colors that are near or outside the limit of that 

color space are changed to fit within the gamut. Without gamut mapping, 

colors that exceed the limit of the gamut will be clipped. Gamut Mapping 

usually provides good results, but having control over gamut mapping is 

helpful in some situations. For example, sometimes you may want the colors to 



be clipped rather than mapped because you prefer the appearance. Or, you 

may want to use other filters in RAW Power to bring the colors back into gamut. 

Finally, if you are going to output a TIFF to Pro Photo RGB, then you should 

turn off Gamut Mapping because Gamut Mapping will limit colors to a smaller 

gamut than Pro Photo RGB’s.

Lens Correction: Apple’s RAW engine can correct for distortion and shading 

(vignette) in cameras with fixed lenses. It does not correct images for cameras 

with interchangeable lenses (e.g., DSLRs). RAW Power automatically applies 

this correction. If Apple's decoder cannot correct the lens distortion for this file, 

a message will appear in place of the Lens Correction checkbox.

TIP: Double-click any slider to reset it to its default value.



White Balance
White Balance adjusts the image’s color balance and tint. Temperature is 

expressed in degrees Kelvin, where lower temperatures result in a bluer image 

and higher temperatures in a redder image.  

You can drag the sliders to set a white balance or use the sampler button. To 

use the sampler, click the sampler button, then click a neutral gray in your 

image. Do not click on a bright white area; you should select an area that is 

uniform in color and that you want to appear gray.  

If you drag the sampler on the image, the white balance values will update 

continuously until you release the mouse button.

TIP: Command-Shift-W is a shortcut for clicking the white balance picker.



Tone
The Tone adjustment allows you to control the brightness of the image. There 

are four related controls in the Tone adjustment. 

Exposure: this slider controls the brightness of every pixel. Setting the value to 

1.0 makes every pixel twice as bright. At 2.0, every pixel is four times as bright. 

Moving the slider to -1.0 makes every pixel half as bright.

Highlights: this slider darkens just the brightest pixels of the image.

Shadows: this slider brightens the darker pixels of the image.

Recovery: this slider works like a “selective exposure”. Only the brightest pixels 

are affected, but unlike highlights, it adjust the brightness just like exposure. 

Sometimes you will get better results with Recovery and other times Highlights 

will work better.

TIP: If you have an overexposed image, the following can give decent results 
quickly: Boost = 0.5; Recovery = 0.5, Shadows = 0.3. You can then fine tune 

the results.

Press the Command key when dragging any slider in the Tone adjustment to 

show another type of clipping indicator. For Exposure, Recovery and Highlights, 

the indicator draws black for pixels that aren’t clipped, and draws red, green, 

blue, or a mix of those colors for clipped pixels. For example, if a pixel is 



clipped in red, you will see red. If it’s clipped in red and green, it draws yellow, 

because yellow = red + green. If it’s clipped in all three channels, you will see 

white. This technique replaces every pixel in the image, unlike the hot pixel 

overlay. Below is an image, but with the Command key pressed while moving 

Exposure. 

If you hold the Command key while dragging the Shadows slider, RAW Power 

will shows pixels that are at 0.0 in each channel. Thus, blue indicates that the 

pixel’s blue channel is 0 and yellow means the pixel’s red and green channels 

are both zero. Because it gets complicated when more than one channel is 

either 0.0 or 1.0, here is a chart that describes what pixels are drawn in each 



multi-channel case:

Pixel Shown Channels that are clipped

Yellow Red and Green

Cyan Green and Blue

Magenta Red and Blue

White Red, Green and Blue

Like the Shadows slider, the Black Boost and Black Point sliders in RAW 

Processing show 0.0 pixels if you press the command key while you drag them.



Depth Effect
The Depth Effect adjustment is added automatically to any images shot on an 

iOS device using the dual cameras. This adjustment is only available on macOS 

High Sierra (10.13). The adjustment allows you to adjust the highlights and 

shadows of the background and foreground independently. It also provides 

control over the definition of foreground and background by manipulating the 

depth mask. 

Highlights: darkens the brightest pixels in the foreground. Press Command 

while dragging the slider to get an overlay of the hot pixels.

Shadows: brightens the darkest pixels in the foreground. Press Command while 

dragging to get an overlay of the cold pixels.

BG Highlights: darkens the brightest pixels in the background. The Command 

key displays hot pixels for this slider as well.

BG Shadows: brightens the darkest pixels in the background. The Command 

key displays cold pixels for this slider too.

Depth: controls what the other sliders consider foreground and background. 

Sliding it to the left makes more of the image “foreground” and sliding to the 

right makes more of the image “background”. So, if you move the slider all the 



way to the left, the entire image is “foreground” and the two background 

sliders have no effect. If you move the slider all the way to the right, then very 

little of the image will be affected by the foreground sliders, while most will be 

affected by the background sliders. 

If you hold the Command key down while dragging the depth slider, you will 

get a overlay of the depth mask itself. Here is an example depth mask at its 

default value and with the depth slider at 5.0. Lighter shades of gray denote 

foreground and darker shades denote background.

Original Image Depth Mask, Depth = 1.0 Depth Mask, Depth = 5.0



Basics
 The Basics adjustment provides some simple, familiar tools. 

Brightness: makes the image brighter or darker using a gamma function. A 

gamma function ignores black pixels and white pixels, but all other pixels are 

made darker or lighter depending on the value of the slider.

Contrast: this is a simple contrast slider to make an image look more or less 

“punchy.” While this is a simple tool to use, consider using Curves for precise 

control (discussed below).

Saturation: this slider controls the richness of colors in the image. Be careful 

with this slider when people are present in the image, as it can make skin look 

orange. Moving the slider to the extreme left creates a simple black and white 

image (“fully desaturated”)

Vibrancy: this slider is related to saturation but doesn’t affect skin tones. As a 

result, it is a better choice for images with people in them but may not provide 

the best results for sunset images.



Curves

Curves is a very powerful adjustment that allows precise manipulation of pixel 

data. Curves can be thought of as a custom adjustment where you precisely 

describe the effect on each channel of each pixel. Each curve expresses a 

mathematical equation. The X coordinate is the input value, and the Y 

coordinate is the output value. In other words, y = f(x). By default, the input and 

output is the same, resulting in no change to pixels. This is expressed as a 45 

degree line,  because at every point on such a line, y = x, and therefore no 

change occurs. Black (0.0) is on the left, and white (1.0) is on the right.



The Curves adjustment consists of four separate curves, one for “Red,” 

“Green,” and “Blue” and a “Grays” curve. The red, green, and blue curves only 

affect one channel of each pixel, while the gray curve affects all three channels. 

Initially, you will only see the Grays curve — you access the other curves using 

the “Show:” popup. Once you have modified some of the curves, you may want 

to see all of them at once. If so, select the “Overlays” setting in the Show: 

popup.

You can click on a curve to add a point, which you can then drag to the position 

of your choosing. The image updates in real-time to account for the change in 

the curve. There are limitations on how close points can be to each other, so 

sometimes the RAW Power will prevent you from adding or moving curve 

points. 

People often use Curves to adjust contrast. To do that, make an S-shaped curve 

in the Gray channel as follows in the image at the top.

The more it looks like an“S,” the greater the contrast. 

At the top of the Curves adjustment are two automatic buttons: Auto Black and 

White and Auto RGB. Auto Black and White is a good way to make sure your 

image has good contrast. Auto RGB also does that, and corrects color casts in 

the image. It does this by changing the red, green and blue curves. Here is an 

example image using the Auto RGB control to eliminate the color cast in the 

image:  



 

The Gamma button switches Curves between a Gamma mode and a Linear 

mode. The current state of the button indicates the current mode — by default, 

Curves is in gamma mode. When in Gamma mode, Curves gamma-corrects the 

data before applying the curve data and then reverses the correction before 

sending the image data to the next adjustment. Gamma is generally a good 

default, but if you want maximum control over the bright areas of the image, 

Linear can be a better bet.

The Equal RGB button controls the way Curves processes the Gray channel. If 

its set to Equal RGB, then red, green, and blue are affected equally. However, if 

it is set to Luminance, then the gray curve affects the red, green and blue 

curves according to the luminance equation, which weights green more heavily, 

and blue the least. This approach avoids enhancing color casts and is much 

easier than converting the image to the “Lab” color space in Photoshop and 

manipulating it that way. 

Here is an example using an image with an S-shaped contrast curve. On the left 

is the image in Equal RGB mode and on the right, in Luminance mode:  



The Samplers section of the Curves interface lets you place points on the curve 

by clicking on portions of the image. The first control sets the black point for 

the image; the second sets the 50% gray point, and the third control sets the 

white point. Each of these can cause the image to change appearance. The last 

sampler is the “target” sampler. It places a point on all of the curves at the 

color value of the pixel you click on with the mouse. Except in extreme cases, 

the target sampler does not affect the image. 

Like the White Balance sampler, the curves samplers update continuously if you 

drag on the image while using them.

In the following example, the color cast is removed using the black and white 

samplers. The sampled points are circled.      



Once any point is placed on the curve, you can move it around to adjust the 

colors similar to the one you sampled. You can delete points with the delete 

key on the keyboard, or right-clicking on the Curve to get a contextual menu.

At the bottom of Curves are the black and white point controls. These are 

simple controls to set the darkest and lightest colors for a given curve as shown 

below. 

 

Hold the Command key when dragging the black and white controls to get 
the same overlay as appears with the Tone adjustment sliders.



Sharpen

The Sharpen adjustment is a simple but very effective sharpener. It sharpens 

just the luminance channel of the image, which provides good results without 

accentuating color noise, unlike Unsharp Mask.

This sharpener is a different algorithm than the one in RAW Processing, so you 

can try each to decide which looks better for your images. Definition (in 

Enhance) also has a sharpening effect.



Black and White
The Black and White adjustment creates a range of monochrome images by 

controlling the mix of red, green, and blue pixel data applied to each channel.

By default, Black and White will convert the image into a monochromatic 

image using the luminance equation. This usually produces a better result than 

simply averaging the pixels or using 1/3 of red, green, and blue. In addition, 

there is a preset menu which allows you to create standard mixes similar to 

color filters placed in front of the camera lens. Examples include Yellow, Red, 

and Orange filters. You can also create your own mix using the sliders.



Perspective
The Perspective adjustment lets you rotate an image in 3D to make lines 

parallel. It is useful for buildings shot upward at an angle, roads and other 

subjects which have strong straight lines.

You can correct perspective in the vertical or horizontal direction. By default, 

perspective will zoom the image in to avoid showing black areas. However, 

that may be undesirable if the subject area disappears from view. In that case, 

use the Scale Factor slider to zoom back out. You will then need to crop the 

image yourself. Here is an example of the perspective filter in action:





Enhance
The Enhance adjustment contains three adjustments for enhancing photos.

Definition: This slider sharpen edges by applying "local contrast".

Deepen: This slider darkens an image without dulling white areas. It works like 

a "Multiply Blend".

Lighten: This lightens images without affecting black pixels. It works like a 

"Screen Blend".



Chromatic Aberration
Chromatic Aberration is an artifact caused by the way light strikes a lens. The 

individual color components split and hit different areas of the sensor causing 

ghosting.

The two sliders control different types of aberration. You will usually see 

aberration near edges / high contrast areas. If you have red or cyan aberration, 

use that slider. Otherwise, use the second slider to control blue / yellow 

aberration.

Here is an example of chromatic aberration:





Vignette
Vignette darkens the edges of the image to draw the viewer's eye to the 

subject (usually at the center).  

Amount: controls the darkness of the vignette.

Radius: controls the size of the vignette.  

Target Point: You can click the target button (yellow, above) to set the center 

point of the vignette. This is useful when the subject of the image is not in the 

center. If you drag the mouse after clicking the target button, the center point 

will update continuously until you release the mouse button.

Vignette is the only adjustment whose effect is applied after crop.


